
Dogiqnfng Malb in Deltacad

We will begin with an assumption of a basic working knowledg€ of X and Y coordinates
and an understanding of som€ high-school lsvel geometry. You ehould also hav€ a good
grasp of Windows 95/98 operation and file managemenl.

Our first €xarnple will be a standard, rectangular opening, double (layer), mat. This
design can obviously he cut !'nanually, or with th€ standard sottware of your
cornputorized mat cutter, hut it will help us to illustrate some ofth6 besic principles you'll
need to design more cornplex mats later.

Our lirBt step will be lo sel€c1 the 'Shepos' tab in Deltacad, and the deiault Shap€s tool
which is "Draw a Rectangle Using lwo Com6G'. We will stad by drawing lhe outer
dim€nsions of the mat whioh will be '11"W X14"H for this examDl6.
Enter the coordinates 0,0 for the lower-left cornor of the mat, or "origin' point. Pr66s the
Enter key aft6r the second "0", and make 8ure you use a comma botween the two
numbers and not a decimal point. The command bar at the lower lefr ponion of th6
screen will now prompt
you to enter the second
point ot th€ rectengle.
Enier the number8'1 1,14
for the width and height
dimensions of the nnat
respec'tively, and pr$s
Enter again. Press the
Cirl+A k€ys to vieur ths
6ntire 1 1x14" r€clangle.
The below rgctangle
should now be shown on
screen: (The X,Y
coordinales of lhe two
corners w9 nave
d€signaled will nol be
visiblo on your screen;
they have b6en added
tor illustration purposes
onry.)
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Now let's draw the actLral mat openings for each layer of n0aii. We'll begin wiifr the
bottom!, or inner iayer of rnat first, since we us{..nally krow the total width of rnat borders.
For our exan0ple, we' use a mat border of 2.5' on eactrr side.

lJe* we'll click on the "[-l0n@" tab on the toolbar, and select the'Draw a Horizontal Line" icon-
Then, let's change our line color to red by clicking on the down anow button (Choose a Color),
just to the right ofthe black color block on the toolbar. Click on the red color block in the palette,
your color block should r0ow be red.
The command barwill now prcmpt you to "Sslectfirst point, or enter X,Y"- The coordinates of our
first point will be 2.5,2.5 ; this is the relative distance, in inches, from our origin point of the mat
which is the lower-left corner (0,0). After entering these coordinates, a short red line segment
should be visible at the lower portion of your rectangle. Move the mouse cursor in the direction
which you want the line to be created, in this case to the right of the initial point.

The cunent instruction promptwill now be to "Enter length" ofthe line, which will be 6",
representing the width ofour mat opening. Press "6" and Enter now. A red, horizontal line should
now be thown in the correct location.

The next step will be to create the
left, vedicaledge ofthe mat opening.
Olick now on the "Draw a Vertical
Line'icon on the s8me "Line" tab.
Again we are prompted to'Enter first
poin{" ofthe line, which we cari do
either with the mouse or by entering
coordinate values as b€fore. Since
we already have the starting point of
this line qreated, (the left end of our
first, horizontal line), it's rnuch easier
to simply hold the mouse cursor over
the left-endpoint of our first red line.
When you do this. a small "crosshaii
will be v|srble. This Indicates that you
can now "snap'precisely to this point
by clicking with the mouse now.

After clicking on that point (2.5,2.5),
the prompt will be once again to enter
the length ofthe line, which will now
be 9". Fress "9" and "Entef now to
finish the vertical line.
The drawing should now look like
this:

At this poinl, there are several
methods of completinE the "
reqangular
opening. The one we'll use will give you a bit more practrce using the "crosshair-snap" feature
of Deltacad.



Select the 'Draw a
Parallel Line" icon ftom
the "Lim€f toolber.'Selec,t a Line' i8 lhe
cornmand prompt, Click
anywhero on th€ bottom,
horizontal red line, and a
parallel r6d lin€ will
appear, following the
rnouse cuBor location.
Move the curaor onto the
top endpoint of the
ve ical red ling and click
when the crosshair
appears. The top line will
now be drawn, as below:

For the final lin€ ot the
reclangle, click onto the
lgft-vertical line and
movo tho cursor to the
right end onto the right endpoint of either the top or bottom red horizonlal lines. Click the
mou96 when the crosshair aDoears as
before, and your mat opening is now
cornplete!

To draw the four lin63 of the outer, or top .
mat layer, w€'ll first change our lino color
back to black. lf you'v€ forgotten holv to
change colors, refer back to the
instruc{ions abov€.

Re-sel€ct the "Oraw a Parallel Line" tool
icon from the "[-[mo" tab. Click on and
selecl eny of th6 four red lines; the line
will be '8slec{ad' when it lights up in a
different color, usually red. (Red lines will
show as selected in mag6nt€). The
prompt will now read: "Enter oflset. . .'
Move the mouse cursor to the ggEldC of
the r€d r€ctangle a short distance and
enter an offsel, or distance from our
reference line of.25. (This will roDres€nt th€ width ofthe inner/ bottom mal r€vaal.)

Tip: lf yo!.ir new, black lir0e appears on the wiong side ofthe red line you selected,
simply prsss the "Clrl + "Z'keys. This is the keyboard shoricd command for "Undo", and
can be usad enylime
you've made a
mistake orwould like
to back up a siep in
your drawing.

\ r , , , ,0



Repeat this sbp tor each of the four
red lines making up the red rectangle.
A really nsat speed feature of
Deltiacad is lhe abitity to uss lhe right
mouse buttcn instead of ths Enter
key, For the second, third and fourth
lines all you need to do is cllck to
select the ling, move the cursor to the
correcl side of S|e line, and rlght-
click. Cool, huh? Your drawing should
now look like this:

Notice however, that lh€ four now
black lines are notjoin€d at the
corners, Thig is because they have
reialned the same lelglh a8 the red
lings they w€re created parall€l to. To
join hsse linss in pr€cia€ com€I8, we
first ne€d to sslect he'Edltr bb trom .
the toolbar The various tools on thE
Edlt tab allow you to chang€, or
modify, many ofthg €xlstlng qualities
of your drawing's entitle8 (lines, srcs, oo /
otc.)You may move your curgor
briefly over eEch edit tool to got an idea of what type of changes arg po$lble wlth the Edlt tab.
Select thE "CrEatE a ComE/ tool lcon, which looks just llke a rlght€ngle comer. The command
prompt will read: 'Select frst lin6 or arc". Cllck on rny of lhe four, un-joinod blsck line6, and hen
an adjaGnt line you want to join it to (Select Eecond lino or arc). The tu/o 8€l€cied lin€a will no\'v
be joined in a precisg go{egree comer. R€peat lh€ proc€ss for ths othgr hr€€ comsra and your
double mat is now complstel lf your drawlng dossn't look like thlsl

then, w€fl, you goofed somewherg. Go
back and check each gtEp again. Don't
forget that busty Undo command, (Cti +
Z). lt can r€ally make your day.

Edlt tah aold "Cr6ato a Gorm6!'' tool

Edltlorg th@ Mat Drawlrlg

l'lere's where the fun be9in6, gang. We
aae now going to make gome simple
changes to the mat in oder to create a
unique design.
The first modifrcation is going to be
creating slanted, or cramf6rs4 comeas on
two, diagonally opposite comers of the



mat. Eutfirst we're going to save the design as it is right now, as we may want to go back to it
later. Save it as'Dblmat1" for now

Click on the Edilt tab on the toolbar. and
select the "Create a Chamfer" tool icon, 0t s
just to the right of the'Create a Corned'icon
we just used). The command prompt will
rcad. as before. "Select first line or arc". Click
on the left side, vertical red line ofthe mat, and then the top, horizontal red line when prompted to
select the second line. The promptwill now ask you "Enter chamfer length'. For this example we
will enter .75, for a %" chamfer. (this is clumsily referred to as
"Slant Point" in the F-6100 software.)
The upper-left corner ofthe red, or inner mat laydr will now have
an angled cornor, as shown at dght:

To repeat the operation in the lower-right corner, simply click on
the right side red line, and then the bottom red line, and either
press the Enter key or click the right mouse button to crsate
another %" chamfered corner. Easy, right? Yes, but we're only half
way mere.
We now want to create a corresponding chamfer on the top
(black), layer of mat.

Click now on the "L[m@" tab. and select the "Draw a Parallel [-ine"
tool icon. When prompted, select the upper left chamfer, or slanted red line ofthe design. Move
the nnouse cursor up and to the left slightly to cor.ectly orient the new line, and enter .25 as the
offset. (Sinco we used the same %" as our previous oflbet, you should
only nged to press the Enter key or right-click the mouse.) Repeat this
step for the lower-right cornsr as well now.
lfhe drawinE should now Nook like thb:

tr,low all we need to do is create four corners where the two black chamfer
lines will meet the four sides of the mat opening. [f you are having
difficulty clicking on the short chamfer lines, you may want to Zoom in lo
get a better view of that region of the drawing.]lo do that, click on the
"Vi@w" tab, and use the default View tool (View objects within rectangle).
Simply click once near the aaea you want to see more clearly. A view box
will appear and follow the mouse cursor until you click a second time
once you have enclosed the view area desired. Let's do this now for the upperleft corner, just for
practice.
Ah. much better. non?

i

Click back to the Edit tab, and select the "Create a comer" tool.
and then the chamfer we want itjoined to.

This drawing should now look like this:

OK, the rest is easy. Click on the other three palrs of lines we want
tojoin, and our new mat design is now completel.

llip; N@t sure lnow to use a certair| Eeltacad tool? Sin'nply
p?ess tfde Ff key at amy tiflne to display the Heip scr@@n for
the t@ol tlnat is cuff@0lth,/ Eel]ected.

Click on the left vertical black line



Drawimg lonsot @peoi0ngs

Lets say you wanted to place two small "insef openings in the borders of lhe two chamiered
comers that we.e just created. Here's one tt/ay to do it.

Lets start with a zoomed in Vtr@w of the lower-right comer area of the mat d€sign. G€t in fairly
close, as we'll be wo*ing on some smaller details this time.
Click on the l-!no tab, and select the Parallel lin€ drawing tool. Select the black (top mat) chamfer
line, move the cuGor to the righudown slightly, and enter an offset distance 0f.375, or 3/8".

Next, select the "Polnf trab from the toolbar, and
make sure the default Point tool icon "Draw a
poinf i8 selected. The promptwill be to'Select
existing point,... or enter X,Y" For this example,
we will s€lect the !g!etdgb!99o9!!l$9Ig!
jtsq[ (the 'l'l,0 point), as our starting reierence

point. Make sure it is visible on your scr€gn, and use the scroll-ba(s) to move the drawing image
if you can't.
When th6'crosahsirs" of the comer point light up.at th€ lower-right comer, click the mouse to
select it. The promptwill now be much the same pxc€pt the wgd "Offsef willappear b€low it. We
will be creating s Temporary Point 1 inch to th6 lglt and '1 inqh gbove thig corner point. To do this,
enter -1,1 a6 the off8et. (N\,legative (-) distances Er€ l€ft (X) and down (Y), and posltive (no plus +
sign needed) distances are to the dght (X) and up
ry).

A small red dot, or'tempomn/ point, will now be
visible above and to the left of the comer
reference point. We'll use this as the stiarting point
ot our inset opening.

Click on and select the "[-trrne" tab now, and select
the 'Draw a horizontal line' tool. Select th6 red
temporary point as the first point, move the cursor
slightly to th€ lefr, and 6nt6r a line length of 1.75.
Select the "Draw a Vertical Line" tool, and drgw a
vertical line up 1.75" from the same stgrting point.
f'{ow. with the same Vedical line tool active. draw
anothEr linE up from the lefi endpoint of the
bottom, hodzonlal inset line, also'1.75'. For the
last line, click back to the Horizontal line tool and
draw a line to comDlet€ the 1 .75' souare. The
drawing will now look like this:

OK, now click on the Edlt tab, and again select
the "Create a come/ tool. T.im the two uDoer left
corners ofthe inset opening to form a clean
chamferjust like we did with the corners ofthe
marn openrng.
Next, let's draw the bottom mat layer, in red once agsin. Click the
!-ino tab, change the line color to red, and aelect the "D.aw a parallel
line" tool. Select any ofthe lines of the inset opening, move the
cu6or toward the insid€ of the opening, and enter an offs€t of.'15 or
-1l8'. Repeat this for the other iour lines of the inset opening until it
looks like this:



1

[\ow select Edit, Create a corner, and trim up the five overlapping line intersections of the inset
bottor,r mat layer. I know, you didn't think it was going to be this easy, right?

All that's left now is to place another inset in the diagonally opposite comer. We could redraw
another one like wejust did, but "hlah, way too much workt" There is a much easier, faster way
to do jt, using the "S@n@ct" tab, (see below), which we haven't covered yet.

Select "S@0@ct", and make sure the detuult "S" or Selection tool is active. This tab allows us to
make modifications to any or all entities in our drawing, such as Move, Rotate, and Nnirror. For
this example we'll be using the Rotate tool, but notjust yet.

First you'll need to select the entire inset opening; both layers- you a@ still zoomed in on it, right?
Lising the Select tool is much like using the "Viely objocts in a rectangle" tool, in that you draw a
box arcund the object(s) you would like to 9g!9ql rather than view closer.

Starting from below and to the right ofthe inset openang, click once, and then move the selection
box around the entire in6et opening, up and to the left, th€n click again. Allofthe lines in the inset
should now have changed color; black lines becamg rEd, and red ones are now magenta.
l"llOWEVER, depending how far up and to the left the cursor was when you clicked the second
time, you may have inadvertently selected one or more lines from the main mat opening as well.
To "Deselect" those lines (and you'll know which ones th€y 8re by their changed colors), hold
down the Control (Ctrl) key as you click on each one and they will toggle back and forth between
selected and unselected. Exciting stuff, eh?

Once you have properly sel€cted allofthe lines from the
inset opening only, click on the "Rotate" tool icon- it's the
one that looks like a CCW anow. lfhe oromDt is now "Enter
rctiation angle or press Enter for 90 ". Go ahead and press

Enter now, just for kicks. The inset opening should now
have rotated i[!l!!g 90 degrees counter-clockwiBe.
Press Enter 3 more times to complete a full 360 Cegrees
of rotation to get the inset back lo its original position.
(Now yor!'re thinking, "Yeah, so?')

llow we'll need to zoom out to view all of our drawing, the quickestway
being the Otrl + A keyboard shortaut. (A for view All). The inset opening
should still be selected. Click now on the "Set the base poinf' tool, just to
the right of the Select tool icon. This will allow us to rotate the selected
entities around ary point we designate, which in this case will be the
absolute center ofthe entire mat itself.

ln the lower righl corner of llhe screen, click on the little circle-
with-a-dolin-it thingie, {see above), which is the'Snap to
center point" tool. tulake sure it turns red when you click on it,
lhen move the curcor to the edge ofthe outer rectangle ofthe
mat. When a crosshair aDpears in the exact center ofthe mat,
click the mouse. l{ow you can click the Rotate tool again, this
time enter 180 as the rctation angle, and press Enter. Whoal
trJow ttrie inset is in the uppeFleft corner, but misslng from the
lower leftwhere we also want one to stay, right?.
Don't panic, simply click the "Copy" button, just to the right of
the color selector, and press Enter again. The drawing should
now look like this:



l{ow let's say you wanted to make this a horizontal image mat instead ofvertical. Click the Edit on
the main menu bar (NOT the Edlt kb), and click on "Select all". This will highlight the entire
drawing all at once. Select the Rotate tool again, (if it isn't still active), and enter a rotation angle
of90. The drawing should now be shown horizontally, as the base (rotation) point fora group of
entities willalways default to the center of the grdup itself. Right?t?

What ifyou wanted the inset openings to remain in the top-left and boftom-right corners as they
were in the verticaldesign? No problem;Allwe have to do is break outthe "Mirr@d'tool.
Before using the [rninor tool, we have to create what's called a "mirror-line". This line will be the
reference line that the entity or group of entities will be flipped, or miffored, from.
Click on the 0-imq tab, and select "Draw
a horizontal line" tool. [n the lower right
area of the screen. click on the "SnaD
to ldopqid" icon. Then move the
cursor to the center region of th€ right
(or left), eOgC line ofthe mat drawing
until you see a crosshair point appear.
Click whgn the point appeaF and then
drawjust a short horizontal ling from
that midpoint untilthe drawing looks
something like thisr (The mirror line is
shown here in blue, yours may be any
cotor,,

Minor lio'ie

I
Now click on the S@lect tah again, ard draw a
selecting box around the whole dra\,ving. Click on the
"niirror selected objeots" tool icon, and wher0
prompted to "Select 0T0irror line", click on tho
tennporary miror nine we just created. lfhe drawing
should now be inverted venically, with ttre inset openings back in the !.ipperleft and
lower right corners. Nexii, we need to move the drawing so that ttrte nower-lefr cor!'ler is
again aligned at the 0,0 point. Olick the "Move selected entities" tool, and er|ter lhe offset
distanae o{ 1.5, -1.5. llhis lJ'Jill rr0ove the drawing both rigtrrt ard down 1.5"

To rernove the minor Nine
frorn the onat drawing, alick
on the "Edit" tab, (this will
also de-seleat all entities),
and select lthe Er, 'Erase an
object'tool. Then just click on
the mirror line lo erase it, and
you're good ito go!



Radius amd ArGs

Rememberthe basic double mat
design we saved (Dblematl),? [-ets
save our current design first, close it,
then re-open the double mat design.

The first thing we'lldo is create rcunded comers in two diagonally opposite cornersjust like we
did with chamfers. Click on the'Edtrt" tab, and select the "Create a radius" tool, which looks like a
rounoeo corner,
Create a rounded, or radius corner in the upper leftcorner of the red, or bottom mat layer. Do this
the same way as the chamfer tool works, and ent9r 1 as the radius whon prompted. Repeat the
steps for the lower right corner as well. Your mat ytill look like the drawing (below-left):

To create a corresponding radius in the top (black) mat layer, click on two of the lines you'll be
joining and enter a .adius that is %" la.ger than the fiGt one, or 1.25. Do this for just 9!9 of th€
two corners. (see above-nght)
What ifyou dldn't know how large the first radius was? The'D[0m@nal@n" tab in Deltacad allows
you to determine the dimensions ofa variety of entity typeE that you have already drawn.
Click on the Dlrmenatr@m tab now. select the "Draw a radius dimension" tooland click on the
radius ofthe lower right corner. A small pointer€rrow willappear, designating where the
dimension information will appear when you click again. You may make the arrow appear either
inside or outside of the.adius you've selected. lt should now show as 1.00.

You rnay now complete the top mat radius comer with
a 1.25 radius Don't forget to erase the radius
dimension of 1.00 before proceeding turther.
For a review of "Rotate'. let's rotate th|s desqn as we
did previously and make it horizontal.
Refer to the last section ifyou need some help. The
mat drawino shorlld now look like thisi

Di|lnensi@rn Tah amd Radius drawimg @)ptiom
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Before d@€electimg the full drawing and proceeding further, click the'Move selected entities"
tool. Enter the Otfset of 1.5, -1.5 again to realign the drawing with the origin point of0,0. This will
De rm nt when it becomes time to import the design into the F6100

0{owwe'll add a couple of inset openings as we did beforc, but with a slight variation, justto make
it interesting.
Start by selecting the p@[r0t tab, and select the lower]eft comer of the mat as our reference point.
Then enter an offset distance of 1,1. A smallred temporary pointwillappear 1" to the rightand 1"
up from the comer, which will now be the origin point for the first inset opening. Select the [-irio
tab, and draw a 1.75" X 1.75" square in the lower-lefl corner, in black. Change the line color to
red, select the "Draw a parallel line" tool, and create a bottom mat layer for the inset opening.
Make the oflbet, or inner mat reveal .125 (1/8").
Select the Edit tab. and the'Create a corned'tool. and clean uD the line intersections ofthe
newly drawn red square.
OK, remember how to use the
"Rotate" function? Select "S@0@at".
and select the entir€ inset opening,
b€ing careful NOT to select any part
ofthe main opening. ([-]int use the
Crtl key).
Tfhen click on "Set the base point",
click the "Snap to Center' icon in
the lower right corner ofthe screen,
and click €nywhere on the oufer
edge ofthe mat. Click on "Copy",
enter 180 as the rotation angle, and
press Enter (or right click). Finally,
click the Edtrt tab to de-select ths
new opening. Got allthat? lt should
now look like this:
All right then, let's zoom in on the
lower-left opening to get a better
look at it. &lsw tab)
Select the "Clra0@" trab, and click on the "Draw a parallel circle" tool- it's the thkd one from the
right, and looks like two concentric circles. Click on the black outer mat €dius, and a parallel arc
will now frcllgw the cursor. The new arc will be .375" or 3/8' away from the main opening arc, so
now enter an offset of.375.
The newly created arc should appear as belowl

Para[0e[ Arc aood Circ0@ t@@[

Ttris new arc tryill beconne the top mat edge of
the inset opening, whiah u,ill he 3/8" from the edge ofthe main opening's top rnat. To
draw ilhc inner mat radius, first ahange the drawing color to [ed.
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Then click on the new arc we just created, move the cursor left or down snightly, and
enter an Offset of .125". Does it look like tlris? (helow-left).

Looks kind of rnossy at t0xis point, I know, hut we can clean in up in a hurry with the
'create a corner" tool. (Edit tab) When you're finished joining the new arcs to the existing
lines, your opgning should look exaclly like the figure at abovo right. Right? Remember
to always slick on the portion ol the lin6 or arc thal you want to kosp when using this
tool.

[-et's scroll up and lo the right, so we can get a clos6-up view of the other inset opening,
which we're going to do something a bit differe!"rt with.
Click on the "Create a radius" tool, and for t['0e red inner layer of the inset, oreale a radius
o{ .625 (5/8). For the outer mat (blaak line), give it a radius of .75 to maintain the 1/8"
reveal widthi, See below lefr:

Clic0( next on Eff'ase, and get rid of tlle two arcs of the adjacent corner of ltr'te rnain
opening. We won't be r0eeding these anyrriore. llhen click on ihe Circle tab, rnake sure
the color is set to blaak, and again select the-"Draw a paraNlel cirole" tool. Click on the
o!,fer radius ofthe inset opening (black), move the mouae cursor left or down, and enter
an otfset of .375". Change your drawing color back to red again, click the last arc
created, and enter an offset of.25'(bottom mal reveaN of our main opening). Your
drawing sFould appear as above right.
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Now all that's left i6 for
yo!.r to creaie new
corners. Click Edit,
"Create a comei, and
complete the drawing.'llhe final product shorild
look like this:

Just a few more easy
steps, and we'Nl be ready
to c!,it!

@llg: Before you save
your design, click back to
the Polnt tab, and alick
on "Erase temC'. lfhis will
remove any temporary
points yor.i cr€ated to aid
in your drawing. lf th€se
points were brought into
yoLnr out file inedvertently, they could wreak havoc with the Cut file routing on th€ F-8100.

Cuttlmg V@ur Now Mastonpleco

Now lhet your drawirNg is done, you oan't wait to cut it on that dandy F-6100 CMC, can
you?
f{ere's how you do it:

'1 , Click Fil€, Save As to give t['le design a tinal narn6. Click File again, select Fxport,
and th6n "Drawing lnterchange Fil6 (.DXF)', and click Save. On Version 5.0 of
Deltacad, this will bring up an option window, giving you a choio€ b€tw€en "Entity
Types" or "Line WeiEhts". Ohoo8e the default option of Entity Types, and click th€
"Save as .DXF" button.

2. Open the F-6100 program, and click o!'r the "Designer's Choice" button. In the
Designer's Choice screen, Enter the rnat size in the initial Setup box, Click OK and
Exit. Tl]en click File, Innpon OXF, and locate the DXF file that you've just converted.
Click Open.

3. "fhe dosigr| will first appear on your screqn in white, or 'tenced" (s€lec,ted). lf you
don't want io alter your design in any way, press Otrl + F to tum off the Fence
feature. Al! lines/entities should now sl"iow in their conect color(s); i.e. black and r€d
in this example.

4. Click "Cut", ar0d follow the r0orrnal cutting procedure.
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@rawing a 5-p@imt Star im Deltacad

1 . Select the Shapes tab, and click on the "Draw a Rectangle using two corners" tool.
Enter the coordinates 0,0 for the lowerleft comer, then 10,10 for the top right
comer. lfhis rectangle
will be the drawing area
for the star.

Now select the "Draw a
triangle, square, pentagon, etc.'tool. Ther0 alick the "Snap to
lower-right of the soreen. Move the cursorto the edge ofthe

Cente/' icon at the
reclangle you have just

draw!'1, and click whe!'r
you see the crosshair
appear at the center of
the rectangle.

Next, enter 5 a8 the
number of corners, ther'0 6nter the offset coordinates 0,3. This wil! result in a
pentagon i!'0the center ofthe fecta0rgle.

Select the Line tab, and the "Draw a continued line" tool. Starting from any ofthe vedic€s of
the pentragon, draw a line to the opposite vertex, until you complete a star shape at the comer
you began with. (See
figure 2 above) Right
click the mouse to end
the continued line.

4. Select the Edit tab,
and the'Split a line,
circle, arc... etc."
iiootr. Click once
near the center of
eaoh of the five
lines you have just
drawn to forrn the
star shape. (See

5. Select lhe "Create a Oornef
tool also frorn the Edit tab.
Click each pair of adjacent
lines to create 5 new corner
intersee'tions. (see figure 4l
aDove).

figure 3 ahove). 
'fhis \l/ill break each of tf0e lines into 2 shorter line segmer s.

Select the "Erase an Object" tool, also from the Edit tab. Click
on the pentagon to erase it. The s-point star should now be
corY!prete.



Dnawfing a Cust@mn Arch

You nnay occasionally get requests to cut a m0at for an unusual arch-shaped artwork,
often a needlework pieee. Since the F{100 template (patterr0#22), does not offer
unlirniled design flexibility, it may he necessary to draw these designs in CAD. l-lere is
an example of such a design.

'n. Eegin by accr.irately rneasuring the artwork, and determining the dimensions shown
in lthe diagram below.

1.25 1 .25

'10.50

8.75

l

3.00

'14.00

3.00

i1.1875

1t6_00

I' 3.00
' l

20"00

2. ln DeNtacad, select the Slrapes tab, and draw the
rylat size of 20" x 16". Enterthe coordinates 0,0 for
the first point, and 20,16 for the second point.

3. Selecli the L0r?@ tab, and change the drawing color lo red. Create a parallel line 3"
fro!"0n the bottom ard sidles of the 0nat rectangle. Then rnake another line 8.75' above
the line for the hotto0n rnat border. This is the opening
height to the "shoulders" of ittle arch opening. See diagrani
Detow.
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8.75

3.00 -

I

3.00

Now draw a parallel line 1.25" inside of both of the side borders ofthe mat openir0g.
lThese will represent the Widtb of the "shciulders" ofthe arahod openi!'rg.

Select the "Draw a Vertical [-ir0e" tool from the Line tab, and click the
midpoint" tool i!-i the lower rigtrrt area of the screen. fuove the oursor
over the top line of tlne rnat, and click when to you see a crosshair
appear at its nnidpoint. fuiove the cursor downward, and €nter a line
length oli 2.5". Your drawing shound now appear as below.

"Snao to

ilffi
lD|.w I v8rtical linol

lEli0Jl]ligEi4l

ffi
2.50

-  -  1 . 2 5 1 . 2 5



6. Sele6t the Cirole tab, and thc 'Draw a circlnlar arc
tising three points" tool. (Make sure the drawing
oqlor is set to red). Draw an arc with 3 conaecutive
alicks using the three points shown below.

7. [Now we jusli need to clear] qJp ttrie drawing hy creating corners wittrl
the "Create a cornef' tool. tsut firsilwe'll have to split the horizontal
line w[Tich will form the arch'shoulders" into two line segrnenls.
Select the Edlrf tab and lihe "Split a line..." tool, and click once in
ttrre area of the line shown above.

E. Select the
"Create a corner"
tool, and join the
appropriate lines
ano arcs
logether at tl're
poiflts shown
circled here.
When {inished,
alick the "Erase
an object" tool,
and deiete lihe
tllree \rertioal
lines that are no
longer needed.

I)q

o

OO
'e)

Erase lhese three lines

It

Split l ine here

o



Nlow that the bottom nnat layer of the drawing is complete, we simrply create the top
rnat layer gqtg!€l€ @fthe existing layer, at illne designailed distanae (mat reveal) away.
Seleot the Lrir?@ tah, and tlxe "Draw a paral|el line" tool again. Ctrrange ilhe drawing
eolor to htack, and ereate a line 3/16" (.1E75) from each line.

10. $elect the Ciralc tab, and the'Draw a parallel aircle" tool.
Change the drawing color to hlaok here ds we[[, and c]raw a
parallel arc 3/16" ahove tine existing red dra.

/ ' . . . . . j ; .

1 1. ll.o 'iinjstrr the drawingl, select the Edit tah, and the "Create a corner"
tool. ".ioiJl the appropriate lines and aros together, and save the tinal
$ersion. The desig0rr is now ready to irnport inlto,ihe F-6100 program
aridlc!.itl

W
Crsat€ a com€f (CTRL+U
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:
Drewing e Fan lt$ign

Drawing a fan shap€ is quib €asy, hI measudng lhe art olk or oti€ct b ofren lhe kicky
parl. You must determine, at the very least, the dimensions and coordinates shd^,n in
the drawing below.

I
2.25

.1875

11.625,2.'t8.00

2.500

L - -- -ro.ru

You will hav6 initially m€a8ured th€ ov€rallwidth end height of tho fan€hapod artwork,
and dstormined the d68ir6d mergins in ordor to affive at th€ mat/frame 8ize. lt is
nec688ary, how€v€r, to knovv tho coordinat$ of the line endpoints, end the arc
mldpoints relalivg to thg outgr mat edggs a8 shorvn in the diagrem.

Notgi fhis desrgn assumes that the a,M< is synntetrical hottzmhny, however it i8
quite comnon to encdlunter pie@s of fan shaped ai which ate nd. ff lhat is the case,
you must obviously measure both sides of the fan and determlne the line endpoint
coordinates for each side,

1. Begin with drawing the outer mat reclangle by selecting
the Srrqpes tab and th€ 'Draw a reclangle using two
comers' bol. The frst point will be 0,0 (as always), and the
s€cond Doint will be 30.25. I 8
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2. Select the Ai0?e tab, and the "Eraw a lirie with two points
tool". Cliak the "Choose a oolor" drop-down menu, and
change the color to red. Enter the coordinates 2, 3.375 for
the first point, ar0d 11.625, 2.5 for the secondl point. This will
draw the red, inner rnat line as shown above.

3. [!low select the "Draw a vertical [ine" tool, and olick the "Snap to
ftflldpoint" icon at the lower-right o{ the scree0'r. niove the mouse cursor
over the bottom horizontal line of the rectangie, and click when you see
the cross|rair appear at the [in6's rnidpoint. Mgve the mouse o!,irsor up
slight!y, then enter a line length of 5.875".
click on the "Snap to rnidpoint' ioon again, and then move ttr're cursor
over the !9! horizontal line ofthe rectangle. Click again when you see
the crosshair appear, movo the cursor down slightly, and enter a line
lengiih of 2.25'. The draw stnorJlol appear as be|ow: (Din0ensions are
shown in this diagram)

l
2 2 5

2 000,3.375 I
5.875

1800
11.625,2.500 1

4. Seleot the Selecftab, ar0d the "S" selection tool. Click on the red li0re at tlre lefr of
the drawing to select it. Then cliok the Minor.tool, a!'rd t|'ren the Copy button (also
on the Select ltab). and cliak or0 either ofthe vertical lines at the middle ofthe rnat.
lfhis wil! create a "minof
copy of the red sla!-lted line
on the right side of ttrle rnat
area.

mm
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5. Selec't the Ctrcre iab, and the 'Draw a circular arc usirE three points" tool. Click the
"Choose a color" dropdown menu, and change
the coior lo red. Draw the lower arc with the 3
line endpoints as shown below:

(the bottorn-cer er portion of the design is
snown)

sec0 nt

Draw the larger, top arc ofthe fan in the sam6 menner, using the lower endpoint of the
top v€rtical lins as the arc midpoint. The bottom mal layer of the design is now complete;
now we sirnply need to create a top mat around it witir a 3/16'
r@veal.

6. Select th€ Edft tab, and tfie "Erase an ohject" tool. Click on eacfi
of t[re strort vertical lines to erase them,
Next, select th6 l-ine tab, a!'rd the "Draw a parallel line" tool.
Click on either of the red angled lines to Belect it, move the mouse
cursor downward slightly, then enter an offsst distance of .1875 (3/16").
Repeat this for the other red angled line as well.

7. Select the Ed,t tab again, and the'Create a comef tool. Join each of
the four incomplete Iine-to-arc intersgclions to finish the drawing.

nd pol
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@rawilxg 6En

Mat designs with one or more "inset"
oval openings have become quite
popular, especially for arrangements
of portrait photographs. These designs
do require drawing in a CAD prograrn,
ard can be especially tricky to draw
and import conectly. Part of thg
reason they are so difficult to import
from rnost CAD progrems is that the
.dxf forrnat does not support ellipses
(ovals) or elliptioal arcs. There is a
way to "trick" the program into
importing suoh dEsigns, howev6r, as
covered in this simplified example.

lmset @vatr Eesig|'i

1.

4.

Begin hy drawing a rectangle
(Shap@s tab, "R€olangle with 2
comers tool"), to represent the
mat size of 11"x 14". lfhe lower-
left coordlnate of the reclangle is
0,0 and the upper-right is 11,'14,

Click on the L/r?o tab, and select
the "Draw e Darellol line'tool,
Chango the line colorto r6d in th6
"Choos6 a colof dropdown m6nu.
Croate a parallel line fronn each
8ide, 2" from the top, 1.75" sides,
and 2.5'from th6 bottom ofthe
rectangle. (See diagrann below-right)

Change th€ line coNor back to tslack,
and then create a parallel line
.1875" (3/16), frorr eaoh ofthe red
lines. lfhen click the Edit tab, and
s@lect the "Oreate a Corne/'tool.
,.ioin each ofthe four corners of lhe
rectangular mat opening, on both
the red end blaok layers.

Click the Crrcle tab. and the "Draw
an Ellipse' tool. Follow the prornpts
on the inslruction line in lhe lower
left of the screen to draw the ellipse
(oval). (See step 5 helow)

'v8"



Begin by drawing tlne red, bottom layer oval opening witt] the center point
coordinales of 9.25, 2.5, wtrriah is the intersection point of the lower-right corner of
ttrre red, holtorn mat opening. You may select the aenter point wiih the rnoLlse, or by
manually entering the coordinate points. Enter 0 as the angle, .875" as t['0e first
radi{js, and 1.375'as illne second radil.is

Ctrange the color to black, and use the same cer er point tor the top mat ellipse.
Enter 0 as the angle, 'n" as the first radius, and 1.5" as the seoond radius. (lfhe oval
will have a 1/8" reveal; the main, rectang!.ilar opening will have a 3/16" reveal)

7. Seleat the "Draw a parallel circle' too[, also from the Circl@
tab. Cliak on the outer (hlack) ova[, and] enter an ofllset of

.375". Change the color to red, click on
tl'!e new lglgg[ black oval, ar0d enter an
ofliset distanae ot.1875 (3/16"). The
lower-right porliion oli the drawing should
aDDear like tfris:

5.

6.

Click on lihe Edi[tab, and seleat ttr]e 'Split a line, circle,
arc, ellipse, elliptical arc" tool". Click g@99 on each ofthe
two larorer ovals you have just created, preferahly at abo!.I
the 2:00 o'clock position. This will break each ofthe ovals
into two eq!.ial halves. Do rJOT sDlit the smaller two ovals.

Seleat tlre "Slide an endpoint" tool, also frorn the EdrT tah. SNide the line and elliptical
arc erdpoints so that they meet at their inlended inlersection points. Make s!.ire that
the red and blao0( layers are joining to their respeotive colors. llhen select the Erase
tool, and alick on tl0e unused portions offhe larger ovals to delete them. See below:

Sl ide
endpolnts
to mneet

Enase these tw@ o\ral halves

endpoints
to meel



24

10. tsefore going any fur{her, it's now necessary to reoord the irnportant data about the
complete, inset ovals. The easiest way to do this is to selecl the'E'for Edit tool
from the Edit tab. Ttren click on eiiher ofthe
cor0rplete ovals to access its "vital statistics".
Write down the Center Poim and both radius
din0ensions for eaoh lave[, as shown at '
rigl"!t. This infor!'rNatiori will he needed latbr
when the oval is re-created in Desjgner's
Choice. lf you haven't saved the design yet,
d@ it n@w.

1 1 . Click baak ito the Erase tool, and detete
both layers of the i!'rset ovals. (Yes, reallyl)
Save the design again, this time with't{tsO'
aitthe end ofthe file name for "no bottom
oval".
Now alick File > Export > Drawing
lnterchange File (.DXF), and click Save.
Wher0 the "DXF options" window appears,
select the "[.drro W@r'gh0s' option and click Save again.

12. Now clos€ the Deltacad (.dc) file, and open th€ .dxf file you j0.ist creat6d. tunake sure
you choose'DXF fil6" from the "Files of l:ype" drop-down options. lfhe drawing will
app€ar the sarrle at first, but if you move the mouse cursor over either ofthe
rernaining elliptical arcs, you'll notice that they f0ave heon converted to a series of
shorter, radial (circular) arcs instoad. lfhis is how the ,dxf forxnat allowa drawings
created with elliptioal aros to be transferred from one CAD program to another, and
stifi produce acceptable quality in the final product, usually a printed copy.

'X 3. You may now use the "Create a cornef' tool to confirm that the line-to-arc
intersections that you drew previous|y are aclually clean. Tfris is sasy to do i!.1 a
sirnple exarlrple sucf0 as this, hut for rnore complex designs with 3 or more partial
ellipses, there will be a whole lot 0nore "oloaning up" to do. When yoLi havo finistied
cleaning [.ip any sloppy intersections, save the design again as a Deltacad (.dc) file,
once again with a slightly different tile name. Ex: "1 inset oval NBO-B"

14. hlow do another Save as .dxf witln ttle c!,nffent file, hut this time select "Entity Types'
from the "DXF Optio!'rs" dialog box. T0ris .dxf file is now ready to import into t0re
Designer's Choice program.

Desigmor's Ch@ic@ lllnpoming .

1. Fron0 the Designer's Choice screen, cliali File > DXF lmport, and open the last .dxf
file created. TLlrn off the white-highlighted Fence by pressing the Ctrl + F keys. Save
the irnporled design as a Designer's Choice file now.

2. Click the Cirale/ Oval tool at the left side of the sareen to bring up the Oval
entry box. Rernernberthe inset oval dirnensions you wrote down earlier
from the Deltacad drawing? Vou'll need them now. tsegin with the red,
botlorn mat oval, and er{er a width of 1.75 (.875" radi!,Is X 2) and height of
2.75 (1.375" radius x 2). Click OK to close the entry box.
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lminp@rting and Tracimg a Scammed l0lnage

Creating a mat design from a soar|ned image can aNso be accomplished, but !'nust firsl
be traced in your CAD prograrn priorto irnporting it into the F-6100 sofrware for cutting.
lfhis example covers the hasic procedure for doi0rg this with most scanners and
DeltaCad.

'n. tsegin by scanning the actual piece that you wish to copy. lfthe original image you
are scanni{rg is very srnall, i.e., a logo frorn a business card, you rnay nol have
enough fine detail in the outline ofthe image when you are atternpting to trace it
later. Oonversely, ifthe originalthat you are scanning is Narger than the scannef bed
itself, you may need to rnake more than gne scan and "splice' the two images back
together laler. This can make thq procgss quile tricky, espocially when rnaintaining
accurate scale and proportion is important.
Note: Fay spgcial attention to placing your original as precisely aligned on the
scanner bed as possihle, since it is not possible to rotate a bitrrap image once it is
irnported into Del{acad.

2. The scanned in0age will us{.,lally exporl dir€ctly to oither the sca!'!nor's own graphio
software, or to another program which you have previously designated, For this
exarnple, we will send the scan to Microsofr Paint, sinc€ it connes with all Windows-
based computers ar0ryay and is tairly eesy to use. Sav€ the scanned design in Paint
in order to create a "bit map" (.brnp) file, so that it can be imported into Oeltaoad
directlv.

3. [f you want to impod only a portion of the scan for tracing, use the Selection
tool in Paint to crop out the area that you.want to irnport into Deltacad. This
will trelp simplify the tracir0g process by eliminating extraneous parts ofthe
irnage that you don't !"ieed anyway. You rnay re-Save the selec|t€d portion of
the design, or sinnply click Edit > Copy to place it on the windows "Clipboard" so that
you can pa8te it into Deltaoad directly.

Open Deltacad, and then eitlner a) olick File, lmpon > Bitnnap File or b) click Edit,
Faste if you have oopied the scan to the Clipboard, ln either option a rectangular
area with a diagonal "X'will appear, designating lhg imported bitrnap image.
Clicking once anywtrrsre on the screen will place the image in the Deltacad drewing
area. lf you have already drawn a rectangle representing the final mat size you will
need, yor.i can place it anwvhere within that rectangle just hy cNicking in that location.
You rnay place the saan exactly in the center of{he rectangular region by clicking lhe
'Snap to Cented'tool in the iower-right, then clicking again afrer bringing the cursor
to any edge ofthe rectangle. Tlren click the Edit tab to complele the plac€niEnt of the
bitrnap on the screen. Noiie: if you click rnore lhan once in the screen area before
alicking the Edit {ab, yor.i llJill innport ryi0iltiple copies of the bitrnap irito Deltacad,
which is a tsAD thing.

For this exarnple, we will be tracing an image of a Space shuttle comrnemorative
patcl'r. lfhe patch may be saanned directly if you have the original, or you may scan a
life-size photocopy of it. (See next page)
Once you trlave ptraced the image into the CAD program, it's sirnply a rnatter of tracing
the outlirE ald/or portions of the design which you want to be cut with the
appropriate lines ard arcs. Since you will usually be tracing a high-contrast black and

Edir \

4.

5.
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white scan, it is often easierto draw initially in 8 cotor gtbg! than btack so that you
can more easily see whal you have traced.

c&"7

6.

:fi
(tu

Begin by selecting th€ [-ine tab,
end the "Draw a Lin6 with two
Point6" tool. Change the drawlng
color to brlght green for ease of
tracing. C|eate a line matching
each of th€ straight lines of th€
petch outline. Don't worry too
much about the exact Dlecement
of the lin€ endpointsjust yet.
(See diagram)

1qb'

A
,l'\i'
I

$[n!"

lqlu



tis7. Now select the Circle tab, and
the 'Draw an Arc using 3 Points"
tool. Trace the small arc at the
lefr side of tl'Ne patch, then the
gradual "S" curve along tl'Ne top
portior0 using two arcs. (This part
rnay take a few tries before it
looks rightl)

8. At this point, you hav€ traced all
of the pertin€nt olements ofthe

l'

scanngd innage, and can now r€move it from the drawing area. Before you sras€ lh€
bitrnap, Savo the design aB sonnething like "patch scan traca 1" to preserv€ what
you've done so far. Thon select the Edit tab, end the "Erase" tool. and orEs6 ths
hitmap by clicking when you s6e lhe large "X" cro6s light up. Save again, this timo as
"Datch trace 1'.

9. The next step is to split the line along the left slde of the design
into two shorter lines, Select the "Split a line, arc, etc." tool
from the Edit tab, and click at about the mid-portion ofthe line
to split it. Then select tho "creat€ a cornei' tool, end join each
line-toline ard line-to arc ir0tsrsection cleanly, (See below)

Spnft thlsnine hene Joim all intensections
witfn C@rner toofl
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10. D,low that we've conr0pleted lihe ouiline of tf0e patch itself, we need to draw the rnat
jayers ttrrat will actually be cut. To do this, simply areate a line or arc paralNel to the
traaed or.itline at the desired distance(s). For this example, the patch will be floated
on a mat with %" space arolrnd to the inner mat, and a 1/8' inner mat exposure.
Siarit with the Line tah andl the
Parallel [-ine tool. Change the
cqlor to red to represent the inr|er
moat layer, and draw a line .25"
fromo eacfo of the 3 lines in the
design. Ohange the oolor to hlaok
tor the liop mat, and draw 3 new
parallel lines .'n25" outside ofthe
red lines, as shown trrere.

1 1. Next select the Cirale liah and ttrre
'Draw a parallel circle'tool.
Change the draw aolor to red,
a!'!d areate a parallel arc .25"
froon the three existing green

arcs. Change the
aolor lto black, a!'ld
draw ttroree more
parallel arcs.'n25"
from the red arcs.

'12. To complete the design, sirnply connect
each interseotion on both new mat Navors
with the "Create a Cornef' tool.

Place the design wiihin the mat area
with the "i/nove" tool. Save the final
design, ltrren create a.dxffile. Ihe
green layer can be deleted or left in the
design for visual reference. Your mat is
now ready to cuil


